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Manufacturer’s Warranty Statement

Galvanic Applied Sciences Inc. (“Seller”) warrants that its products will be free from defects in materials and
workmanship under normal use and service in general process conditions for 12 months from the date of
Product start-up or 18 months from the date of shipping from Seller’s production facility, whichever comes first
(the “Warranty Period”). Products purchased by Seller from a third party for resale to Buyer ("Resale Products")
shall carry only the warranty extended by the original manufacturer. Buyer agrees that Seller has no liability for
Resale Products beyond making a reasonable commercial effort to arrange for procurement and shipping of
the Resale Products. Buyer must give Seller notice of any warranty claim prior to the end of the Warranty
Period. Seller shall not be responsible for any defects (including latent defects) which are reported to Seller
after the end of the Warranty Period.

THIS WARRANTY AND ITS REMEDIES ARE IN LIEU OF ALL OTHER WARRANTIES OR CONDITIONS
EXPRESSED OR IMPLIED, ORAL OR WRITTEN, EITHER IN FACT OR BY OPERATION OF LAW,
STATUTORY OR OTHERWISE, INCLUDING BUT NOT LIMITED TO, WARRANTIES OR CONDITIONS
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WHICH SELLER
SPECIFICALLY DISCLAIMS.

Seller’s obligation under this warranty shall not arise until Buyer notifies Seller of the defect. Seller’s sole
responsibility and Buyer’s sole and exclusive remedy under this warranty is, at Seller's option, to replace
or repair any defective component part of the product upon receipt of the Product at Seller's production
facility, transportation charges prepaid or accept the return of the defective Product and refund the purchase
price paid by Buyer for that Product. If requested by Buyer, Seller will use its best efforts to perform warranty
services at Buyer’s facility, as soon as reasonably practicable after notification by the Buyer of a possible
defect provided that Buyer agrees to pay for travel time, mileage from the Seller’s facility or travel costs to
the airport / train station closest to Buyer’s facility plus all other travel fees, hotel expenses and subsistence.

Except in the case of an authorized distributor or seller, authorized in writing by Seller to extend this
warranty to the distributor’s customers, the warranty herein applies only to the original purchaser from Seller
(“Buyer”) and may not be assigned, sold, or otherwise transferred to a third party. No warranty is made
with respect to used, reconstructed, refurbished, or previously owned Products, which will be so marked on
the sales order and will be sold “As Is”.

Limitations
These warranties do not cover:

+ Consumable items such as lamps.

* Analyzer components which may be damaged by exposure to contamination or fouling from the
process fluid due to a process upset, improper sample extraction techniques or improper sample
preparation, fluid pressures in excess of the analyzer's maximum rated pressure or fluid
temperatures in excess of the analyzer's maximum rated temperature. These include but are not
limited to sample filters, pressure regulators, transfer tubing, sample cells, optical components,
pumps, measuring electrodes, switching solenoids, pressure sensors or any other sample wetted
components.

+ Loss, damage, or defects resulting from transportation to Buyer’s facility, improper or inadequate
maintenance by Buyer, software or interfaces supplied by Buyer, operation outside the
environmental specifications for the instrument, use by unauthorized or untrained personnel or
improper site maintenance or preparation.

* Products that have been altered or repaired by individuals other than Seller personnel or its duly
authorized representatives, unless the alteration or repair has been performed by an authorized
factory trained service technician in accordance with written procedures supplied by Seller.
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* Products that have been subject to misuse, neglect, accident, or improper installation.

+ The sole and exclusive warranty applicable to software and firmware products provided by Seller
for use with a processor internal or external to the Product will be as follows: Seller warrants that
such software and firmware will conform to Seller's program manuals or other publicly available
documentation made available by Seller current at the time of shipment to Buyer when properly
installed on that processor, provided however that Seller does not warrant the operation of the
processor or software or firmware will be uninterrupted or error-free.

The warranty herein applies only to Products within the agreed country of original end destination. Products
transferred outside the country of original end destination, either by the Seller at the direction of the Buyer
or by Buyer’s actions subsequent to delivery, may be subject to additional charges prior to warranty repair
or replacement of such Products based on the actual location of such Products and Seller’s warranty and/or
service surcharges for such location(s).

Repaired Products
Repaired products are warranted for 90 days with the above exceptions.

Limitation of Remedy and Liability

IN NO EVENT SHALL SELLER BE LIABLE TO BUYER FOR ANY INDIRECT, CONSEQUENTIAL,
INCIDENTAL, SPECIAL OR PUNITIVE DAMAGES, OR FOR ANY LOSS OF USE OR PRODUCTION, OR
ANY LOSS OF DATA, PROFITS OR REVENUES, OR ANY CLAIMS RAISED BY CUSTOMERS OF
BUYER OR ANY ENVIRONMENTAL DAMAGE OR ANY FINES IMPOSED ON BUYER BY ANY
GOVERNMENTAL OR REGULATORY AUTHORITIES, WHETHER SUCH DAMAGES ARE DIRECT OR
INDIRECT, AND REGARDLESS OF THE FORM OF ACTION (WHETHER FOR BREACH OF CONTRACT
OR WARRANTY OR IN TORT OR STRICT LIABILITY) AND WHETHER ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES OR NOT.

Revision Date: June 2019
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1.1

General Information
Introduction

The Monitek Messenger is a compact, highly efficient, and expandable
system that is designed to interface to a broad range of Monitek sensors.
It also has the capability to interface with multiple and different sensors at
the same time. Its modular design approach enables several applications
to be customized for a variety of measurements, such as Turbidity,
Suspended solids, Color, % Concentration, and oil in water, using optical
in-line Sensors. The Messenger PC Transmitter has a Touchscreen PC
(TPC). The TPC (or GUI, Graphical User Interface) offers completely
menu-driven screens that are easy to understand and also has online
help. The GUI interface is designed to allow three access levels
(Operator, Technician and Factory) to prevent an unskilled operator from
changing any critical parameter in the setup of the transmitter. The
interface is intuitive with no need for programming codes or program
numbers. The system also includes some self-check operations as well
as the ability to access the basic measurement values without the use of a
multi-meter or even physically accessing the electronics. The system
includes the ability to perform field calibrations while the instrument is
installed in the process and is operating. It comes factory pre-configured
to your application. For most accurate setup we recommend that the user
calibrate on his process sample condition. Please refer to Process

calibration.



Icons used in this User's Manual

& WARNINGS INDICATE SITUATIONS THAT COULD RESULT IN
THE INJURY TO HUMAN OPERATOR OR BYSTANDER. WARNINGS
ARE PRINTED IN ALL UPPERCASE CHARACTERS IN BOLDFACE
FONT

® Cautions indicate situations that could damage the Monitek
Messenger or sensor. Cautions are printed in mixed case characters
in boldface font

Note Notes indicate miscellaneous information and are printed in mixed

case characters, in normal font

1.2 Safety Considerations
e Power source:

This instrument requires an input of 90-260VAC at 50-60 Hertz (unless otherwise
specified). A 24VDC/AC power supply is optional.

Installing AC Wiring:

AC power consumption is less than 50 Watts at 110 Volts AC. Use
#18AWG wire for power connections. Transmitter relay ratings for alarms
and external devices are 2 A at 250V~ maximum; use #18 AWG or
20AWG for wiring.

& WARNING: MAKE SURE THE AC POWER MAINS ARE
SWITCHED OFF OR OTHERWISE DISCONNECTED BEFORE YOU
BEGIN WIRING THE SYSTEM TO AVOID THE POSSIBILITY OF
ELECTRICAL SHOCK. IT IS A REQUIRED TO INSTALL A MAIN
POWER CUTOFF SWITCH NEAR THE SYSTEM WITH EXTERNAL
MAIN FUSES.

SPECIFICATIONS FOR THE FUSES: 260VAC, ¥ AMP

e Proper instrument grounding:

The instrument must be grounded to avoid electrical shock hazards
to personnel, damage to the unit and erroneous operation.



1.3

1.3.1

& THE SYSTEM REQUIRES AN AC-GROUND (EARTH
GROUND) AND ALL SENSORS CONNECTED TO THE
TRANSMITTER MUST BE GROUNDED.

e Do not operate with open enclosure. Exposed electronics will promote
the risk of electrical shock and might cause damage to the unit.

e Do not alter cable length. The instrument was calibrated with a
specified cable length. Altering cable length can cause unstable
signals and void instrument calibration.

e Keep original packing materials. Ship the instrument in the original
packing material to avoid damage to the sensor or transmitter. If
packing material is needed, contact Monitek.

e Mishandling of the sensor is not covered under warranty. Do not
disconnect the interior wiring of the sensor.

Device Installation
Transmitter location, specifications and installation.

The transmitter should be installed using the mounting ears in a
vertical position. The transmitter should not be installed in direct
sunlight, as this will tend to cause abnormally high heat inside the
enclosure, also avoid locations that are close to excessive heat

generating equipment.



Specifications:
Sensors:

Number of Sensors:

Area Classification:

Environmental:
Operating Temp:
Humidity:

User Interface:
GUI

Alarms:

Display:
Programming:
Analog Outputs:

Internal Relays:
Digital Inputs:

Power
Input Power:

Power consumption:

Enclosure Types

Approvals
Warranty

Includes MoniTurb-F, MoniTurb-FS, MoniSpec AD, 210,
MoniSpec A, MoniTurb-S, TS2, Model 22 Probes, Model 25
Probes (includes CSK, CSH, CSS), Model 450 (CS6, CS8), Cell
Density Probes FS4&FS5.

1 to 4 sensors. Each sensor may be linked to a separate 8 points
Calibration table with 15t order or Curve fit linerization techniques.

General Purpose

-14 °F to 122 °F (-10 °C to 50 °C)
0 to 95% RH, non condensing

Touchscreen PC mounted on inner swing panel behind enclosure
door with window.

Low High Alarms and General Fault Alarm are user
programmable, latching or non-latching, energized or de-
energized with programmable alarm delay and hystersis.

Optional, 4 lines by 20 Characters backlight LCD.
Using Desktop, Laptop or touch screen PDA or Panel PC.

Two standard 0/4-20 mA Isolated. Optional Two additional
outputs 0 to 1000 Ohms

Optional, 4 relays fully programmable rated at 2A/250VAC

Four Digital Inputs, fully programmable with activate levels of 5 to
24 VDC

90 to 260 VAC 50/60 Hz
less than 50 watts

Material: 304SS Material:  Fiberglass
Height::  14.76in (375mm) Height:: 13.19in (335mm)
Width: 10in (254mm) Width: 11.85in (301mm)
Depth: 6.8in (173mm) Depth: 6.77in (172mm)
Weight:  19.4 Ibs (8.8kg) Weight: 12.4 Ibs (5.62kg)
Rating: NEMA 4X, IP65 Rating: NEMA 4x, IP65

CE
One year (materials and workmanship)




Installation dimensions for Messenger PC transmitter in fiberglass enclosure:



Installation dimensions for Messenger PC transmitter in stainless steel enclosure:
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1.3.2 Transmitter and Sensor Wiring

System Layout and Interconnections details

[]

BU3

- =
Opfional analog Optional
Outpuf board LCD Connector
Oufl3| and Qutls|
0/4 =20 mA Power to
main board
Optional
Relay Card
Connector
1123 112
— [am)
Tl=l=
()
AC Power Lamp
23|24|25|26|27|28]29|30| 31
P P2 JpL ol 2
Ome| [OEe] (B e | —
com |P|| “mA- mA- EmA=  Ext
JP5 JP6 JP8 #2 #3 HL Lamp
TL213 1651678910112 [13[14]15]16[17]18]19]21|21|22
[am} [am} [am} [am} [am} [an)
+ | = + | = + | = + | = + | =Z || MmN + | =
0 0 0 0 0 &)

CAIN #2- SAIN #3- SAIN #4- SAIN #5-
Direct  FW[12°]  S[90°]

—RS485- —RS232— -—mA—
#1

P9
[ee]
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(] A K
RS485 4] B I-l
|15] ACGND
[16] DSREN-
17| TxD
RS232 E RyD
|19] GND
mA [20] out I+l 1/4 - 20 mA
#1 |21 Ouf -] 0/4 - 20 mA
Out |+ 0/4 - 20 mA
Out -1 0/L - 20 mA
mA [25] out I+l 1/4 - 20 mA
#3 |26 Out |- 0/L - 20 mA
mA [27] out I+l 1/4 - 20 mA
HL |28] Out -] 0/L - 20 mA
Ext E On/0ff external lamp
Lam |30] Input external lamp error
P 31] aND
JP9 Jumper fo resef with power off/on
JP10 Used for boof mode to programm micro-controller

JP1thru JP4
=
K- -]

JP5 thru JP8

Connect 1-2 for sensor [Diodel
Connect 2-3 for probe [1...+2mAl

Connect 1-2 for high Gain |0..7uA rangel
Connect 2-3 for STD GAIN [0..100uA rangel




Connector to
Main PC board
‘BUZ

( v# AT W ( c# 1Y W ( Z# Y W ( L# AT W

sinduy |o3b1Q W

-

NC

NO

lv | OF

RLY #1

NC
NO

NC

NO

NC

RLY #2

NC
NO

NO

NC

RLY #3

NC
NO

NO

G| 0S| 6V |8V | /¥ |9V |SY | vy |V | Y

#1

19

RLY #4

NC
NO

Relay may be programmed as
fail safe to detect power failure
Rating 2 A @ 250 VAC

#2

#3

44

COM

SY|v9| %929

Digital

Inputs

Digital Input #1
Digital Input #2
Digital Input #3
Digital Input #4

Common

To activate an input
apply 5 — 24 VDC for logic = 1
apply O VDC for logic =~ 0O °
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The product is pre-configured at the Factory for the dedicated sensor hardware.
So in most cases, you may not need to change the jumpers on the Main board. If
you really need to change the settings, please write down the original setting

before changing any settings.

1.3.3 Sensor wiring and connections:

The table below shows a typical Forward Side scatter sensor connections to a
Messenger.

MONITURB FS (Forward and Side Scatter) Flow cell.

Terminal | Wire color | Cable ID Signal

1 Brown FS module (-) Direct beam

2 White FS module (+) Direct Beam

3 Black FS module (AC-GND) Shield
4 Yellow FS module (-) 12 Deg. Sensor
5 Green FS module (+) 12 Deg. Sensor
6 -

7 Yellow SS module (-) 90 Deg. Sensor
8 Green SS module (+) 90 Deg. Sensor
9 Black SS module (AC-GND) Shield

Lamp connections

Terminal
1 Lamp (Blue and Red)
2 Lamp (Grey and Pink)

-14-



1.4

1.4

Software Installation

.1 PC Version

System Requirements

Supported Operating Systems

Window 95, 98,NT, 2000, ME, XP

RAM

32MB

Hard Disk Space

5MB

Installation procedure

Close any open programs that are running on your computer before starting

the installation.

Double click on setup.exe.

As the installation progresses, follow the instructions on the screen. Some

Windows system files will be updated to newer versions during installation

of Messenger software. If these updates are done, you will be required to

reboot your PC. If so, repeat steps 1 through 2 of the installation procedure

to continue with the installation. Once the installation of Messenger software

is complete, you will be required to restart your computer once again for

proper functioning of the software.

Welcome screen shown below will appear, Click OK to continue the

installation process. To abort the installation process click Exit Setup.

.,g, Monitek Messenger Setup

be running.

g Welcome ko the Monitek Messenger installation program.
2=

Setup cannot inskall swstem files or update shared Files if they are in use.
Before proceeding, we recommend that you close any applications wou may

Exit Setup

-15-




V. Choose the Destination location.

1 Monitek Messenger Setup x|

Begin the installation by clicking the button below.

Click. this button to install Maonitek Messenger software bo the specified
destination directory,

Direckory:
’7C:'|,P'r|:|gram FilesiMessenger Graph, Change Direckory

Exit Setup

VI. To change the default destination location click on Change Directory.

Choose new destination location using the following screen.

#J Change Directory =

Enter or select a destination directary,

Directories:

ey 0K

£4Program Files

& Messenger Graph

Cancel

Drives:

=1 Iy j

-16-



VII. Choose the program group under which the application has to appear.

7 Monitek Messenger - Choose Program x|

Setup will add ikems ko the group shown in the Program Group bos,
ol can enter a new group name or seleck one From the Existing
Groups list.

Program Group:

Existing Groups:

Accessories
Exodus

HTML Help ‘Workshop

Maonitek Messenaer
Previous Data Test Lkility
Skartup

Continue I Cancel |

VIII. Click Continue.
IX. Dialog showing the status of the files being copied will be displayed.

X. On Completion of Installation Process Message ‘“Installation process
complete” will appear.

XI. Click on OK to finish the installation process.

-17-



1.5Menu layout and Operation

1.5.1 Messenger Software Navigation Tree (Operator)

| Start/Exit Menu |

N2 v v
| Select Language | | Main Menu | | Select Messenger
v
N2 v v v N4
Setup Inputs/ Diagnostic Set Cleaning Set Access Measurement
Outnuts Menu Event Level Screen
Set Alarms | Clear/Reset Menu |
Previous
—>
| Reset Alarms | Data
> Online
Software Revision Data
3 Graph
Settings
— Copy Image
—> Copy Data
> Save As Bmp

-18-



1.5.2 Messenger Software Navigation Tree (Technician)

| Start/Exit Menu

N2 vV
| Select Language | Main Menu | | Select Messenger
N2 Vv v v v v v Vv
Calibration Setup Results Setup Inputs/ Diagnostic Set Cleaning Set Access Set Access Measurement
Menu Menu Outnuits Menu Event Code I evel Screen
—> Factory - —|
Calibration . Setup Results Set LCD —> File Menu :
Nametags Display LS PreDwous
View/Edit | oad Parameters from file ata
—| Calibration 5| Setup Numerical Set Analog _ o
Results Save Parameters to file nline
u Outputs —> Data
. Save Previous Data to file
s Graph Setup Graphical Assign Digital Setu
> Results Inputs | oad Firmware "
Graph
Process S Set Results Set COM Port 9| View Channel Outnut | Graph
S ) : Units —> ;
Calibration | Adiust Hardware Settinas | Settings
N Setup Data Set Alarms
Build Logging —> Zero Dark Current —> Copy Image
Calibration [\ .
—> Optimize Channel Auto
Set Messenger Copy Data
Set Buffer Unit 1d —> Py
View/Edit Size —>| Optimize Channel Manual
“| calibration
Set R_EIay —>| set Park Ciirrent Auta 7ero Save As Bmp
Bubble Reject Functions S
Graph > Threshold —> Set Channel Reference
—>
Setup Results %| Calibrate Analog Outputs |
] > Format
> Fit Data > | Set ADC Gain Manual |
> Set Results
Offset 9[ Hardware Test
S Copy
Factory Table — Lamp Control
—>| Test Analog |
—>| Test Relays |
9| Clear/Reset Menu |
_>| System Reset |
—)| Default values |
—)| Clear Process Calibration |
—)| Clear Results |
%| Reset Alarms |
—>| Software Revision
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1.5.3 Messenger Software Navigation Tree (Factory Level)

| Start/Exit Menu |

Vv v v
| Select Language | Main Menu | | Select Messenger
\ 2 v v v v v v 4
Calibration Setup Results Setup Inputs/ Diagnostic Set Cleaning Set Access Set Access Measurement
Menu Menu Outnuts Menu Event Code Level Screen
—> Factory - —|
Calibration < Setup Results Set LCD > File Menu :
Nametags Display N Pn[e)wtous
3 Build | nad Parameters from file ata
Calibration Setup Results Set Analog i
> Equations Outputs Save Parameters to file > Online
X . Data
—> V|eyv/Ed_|t . . Save Previous Data fto file
Calibration — Setup Sensor Assign Digital Setup
Equations Inputs | oad Firmware Graph
Edit Sensor : :
Setup Numerical 9| View Channel Outnut |
Equations —> FI;\esuIts Set COM Port oW ot 5 Graph
| Adinst Hardware Settinas | Settings
—> Graph S Setup Graphical Set Alarms
Results > [—> 7ero Dark Current — Copy Image
Process Set Results Set Messenger —> Optimize Channel Auto
—>| Calibration Units Unit Id | CopyData
—>| Optimize Channel Manual
Setup Data
S Build —> Loqginq Set Relay —>| Set Dark Current Auto 7ero 5| Save As Bmp
“| Calibration Functions
“' —> Set Channel Reference
5| View/Edit Set Buffer _>| Calibrate Analog Outputs |
Calibration Size
> | Set ADC Gain Mannal |
- Bubble Reject
Edit Sensor —> Threshold —)[ Hardware Test
Equations
Setup Results —> Lamp Control |
Graph —> Format
—)| Test Analog |
> Set Results
Fi Offset —>| Test Relays |
s it Data
—)| Clear/Reset Menu |
| Setup Sensor
“’| Equations >| System Reset |
- Copy —)| Default values |
Factory Table
%| Clear Process Calibration |
%| Clear Factory Calibration |
%| Clear Results |
_)| Reset Alarms |
—>| Software Revision
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2 Setup and Calibration

Sample #
1

The system is calibrated at the factory using clean laboratory standards. For best
results we recommend that the user calibrate using the process conditions. The
system has TWO types of calibration that can reference sample measurements:
Factory and Process Calibration. The factory calibration is to be used as
reference. Calibration may be done in the field using sample conditions; the user
may alter the data acquired by the system in the View/Edit calibration screen. Up
to 8 data points may be entered and the user may select either a Linear fit or a
curve fit equation. For a range where the upper and lower limits are known the
curve fit gives the best fit, if the range is extended, select the Linear fit for best

approximation.
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21 Field Calibration and Curve Fitting

BUILD PROCESS .
CALIBRATION TABLE

Sample #

0OLD
User Yalue - “
pata [

Read Mew Data
STORE Mew Yalue

The Messenger includes a feature that allows the user to calibrate the instrument
in-line. Once the instrument is installed and operating, data points can be taken
and stored using the View/Edit Data selection from the Calibration menu. First
select a sample point from 1 to 8 then the user can select “Read New Data”,
and the Messenger will read the current value and store it. At the same time that
the user saves that sample into the Messenger, a manual sample should be
taken from the process. This sample should be analyzed for the appropriate
content in the laboratory. Once the laboratory has established the value, the
user can come back to the “View/Edit Calibration” Data screen and select the
appropriate sample point. The user should then enter the laboratory value for
that data point. The Messenger has now stored the proper laboratory value to
the actual Data value that the instrument was reading when the sample was
taken. This should be repeated for several values at different ranges of the

expected operational span of the process.
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YIEVW CALIBRATIONM RESULTS
FIT SENSOR 1 @

. for Sensor 1
Using

LIMEAR FIT PROCESS DATA

SETUP SENSOR. EQUATION
BACK

. 057678 1,15157 172730 2,20214
linear ft curee R

Edit Sensor Equations
TAEBLE
BALCK

Once at least three values have been stored, the system can perform a curve fit.
Select Curve Fit from the Calibration menu and the Messenger will fit a Linear fit
or a curve fit through the data points that are entered into the sample data table.
The Messenger will then display the curve, and that calibration curve will become
the active curve for the instrument. The Messenger can be calibrated and
programmed to read the same value on the front panel as the concentration
value that was determined by the laboratory. This unique method is the ideal
way to calibrate an in-line device because it takes into account the real dynamics
of the process and allows the device to read out in the same units that the user

will receive from the laboratory.

To Access Process Calibration you need to enter “Technician Access” level and
to Access Factory Calibration data you need to enter Factory access level. The

following procedure explains in step how a Process Calibration may be done:
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> Set the Access Level to Technician and then select Calibration menu.

. MESSEMGER

Help

SET ACCESS LEYEL SETUP CALIERATION MENU

Current access level is: m
Technician
Setup Factory
Calibration
MNew Access Code m

Setup Process
Calibration

PATN MENLT

» Select “ Setup Process Calibration” and Then “Build Calibration”

» Up to FOUR sensors may be configured in the Messenger. Typically
Sensor #1 corresponds to Result # 1 and Sensor # 2 corresponds to
Result # 2 and similar setup for 3 and 4.

> At least three data calibration points are needed to get a good
representation of the data curve. If you are only doing Turbidity then all
you need is to calibrate sensor #1. Enter the value for the sample in the
cell and then press “Read New Data”, you may want to repeat pressing
“‘Read New data” until you feel that the number is fairly the same between

successive reads. Press “Store New Value” to store selected values.
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BUILD PROCESS .
CALIBRATION TABLE

Sample #

0OLD
User Yalue - “
oy

Read Mew Data
STORE Mew Yalue

You may proceed to enter the various calibration data points by selecting
Sample # (1...8) and entering the corresponding values.

When done go “BACK” to previous menu and select “View/Edit
Calibration”.

In View Calibration Results the user may review or edit the calibration data
and then view graph to review the shape of the calibration curve as shown
below.

The system will show the Linear fit and curve fit curves. User may select
which curve fit represents his process better.
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Help Help
YIEW CALIBRATION RESULTS RLIBRATION F

for Sensor 1 Or SENSO

Sample # Data
1 01378 c36s T
09148
15733 *0ze
o 2584 T

o F 0.34613 069225 103838 13845
linear fit curve At

Edit Sensor Equations Edit Sensor Equations

GRAPH

» Using “Fit Data” menu you may select either to use the Factory or Process
calibration for sample analysis. You may select “Factory Calibration” data
as reference but in most cases the process calibration will be more

accurate as it represents the sample and not the factory standards.

Help

FIT SENSOR. 1

Using

CURYE FIT PROCESS DATA

SETUR SENSOR EQUATION
BACK

> You may repeat the above procedure for the various sensors that are

connected to the system.
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2.2 Analog Outputs and Alarms

The system includes TWO analog outputs that may be set as 0-20 mA or 4-20
mA or 20-0 and 20-4 mA (Reverse acting). Two additional analog outputs may be
added as an option. Also OPTIONAL the user may add “Relay and Digital Inputs
card” with four SPDT relays for process alarms or controls, the same board
includes 4 digital inputs for additional control by external devices like a PLC
(Programmable Logic Controller) or other equipment. The Analog Outputs (4-20
mA) have been calibrated at the factory and may be trimmed or re-adjusted by
the user under the “Adjust Hardware settings” screen menu. These analog
outputs values are a direct function of whatever values are on the display. The

4-20mA outputs operate over a wide range, a minimum of 25 to 1000 Ohm load.

The alarm contacts are also controlled by the display value. The alarm values

are selected and Setup in the “Setup Inputs/Outputs” menu.

BUBEBLE REJECT THRESHOLD .
Max. allowed change per
second {0 = off})

Bubble  Filter Delay
Reject

Channel 1 _'E:-:‘;. _E:E!E

Channel 2 _'E:-:';. _E:E!E
Channel 3 _'E:-:';. _:s:ec
Channel 4 _'E:-:‘;. _E:E!E

Set Default Yalues

The Messenger also includes a feature that allows the customer to dampen the
response of the system, by including added signal filtration. A unique bubble
reject feature is also available; this feature allows the system to reject spurious

signals caused by bubbles presence. The factory default is set for 5% and Filter
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response to 5 sec. The Bubble Reject feature control may be accessed from the

Setup Results menu.

2.3 Display Units

To display the process variable or sample Analysis the user should select
MEASUREMENT SCREEN.

The display units are the units of measure that the user wants to appear on the
display. This bears no relation to the calibration values, it is simply a tag
displayed below the sample process result variable. This is selected from Setup
Results = Set Results Units.

SET RESULTS UNITS

Resulk 1
Result 2

Result 3

Result 4  |FTTRNSREL

Up to NINE characters may be entered.
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2.4 Data Trending Display and RS-232 Output.

The system includes memory storage of process results data. This data is stored
and will NOT be lost if power is disconnected from the transmitter. This feature is
meant to allow operations personnel to check on recent changes or trends in the
process by displaying the trends directly on the display of the linked device (PC,
PDA or TPC) logging again.

SETUP DATA STORAGE SIZE .
Total mas. stored Results = 8000

SETUP DATA LOGGING

Store Result 1 every

m- Seconds

Result 1 Storage Size

EATM Volues

Result 2 Storage Size

Store Result 2 every

m- Seconds
EEE- Yalues

Store Result 3 every

m- Seconds

Result 3 Storage Size

Store Result 4 every
m- Seconds

Set default values

Set Data Storage Size

EATM Volues

Result 4 Storage Size

EATM Volues

Set default yvalues

The Maximum number of data points stored is 8000. The user may allocate all
the 8000 points to one sensor (Result) or may divide them as needed.
Based on the default setup of one data point every 60 seconds and 500 points

per result, the Messenger will continuously have the last 8 hours of sample data.

Selecting Measurement Screen and then selecting Graph Data for displaying
results display the data trend. The Graph settings (Setup Graphical Results)
may be accessed under “Setup Results menu” where maximum and minimum
values for the y-axis (the process variable) as well as the time interval for data
collection and display. The system will then display whatever data is in storage
and the time span on the x-axis will be whatever the selected logging span

duration. Plotting the data does not erase or corrupt the data, so the user can
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actually re-plot the data and zoom in or out on the y-axis by entering different

values.

2.5 Self-Cleaning Interval

The interval between automatic self-cleaning cycles is selected from the “Set
Cleaning Event” option on the System menu. The value is entered in minutes.
The MONITEK MESSENGER holds the display and all outputs at the previous
value while the self-cleaning cycle is underway. Once the self-cleaning cycle is
complete, the instrument returns to normal operation. The self-cleaning cycle
can always be initiated or tested by selecting the “Start Clean Cycle” option from

the Set Cleaning Event Menu.

SET CLEANIMNG E¥YEMT
Clean Event 1

|_Clean Event 1 _ | Clean Event 2

SET CLEAMIMG EYEMT
Clean Event 1

|_Clean Event 1 | Clean Event 2

Cleaning Frequency “

in Hours - 999.9

Cycle Duration in m

Cleaning Frequency “

in Hours i - 999.9

Cycle Duration in m

Minutes 0.01 - 999.9

Purge Time in m

Minutes 0.01 - 999.9

Minutes 0.01 - 999.9

Purge Time in m

Minutes 0.01 - 999.9
Selected

Device Relay 1

et LR CLEANING CYCLE

Selected

Device Relay 1

b LR CLEANING CYCLE

When manually starting a cleaning cycle make sure you have the variables set
properly and a device selected.

Note: The Monitek Messenger Provides the electronic control for the signals
needed to activate cleaning jets. The user must provide the appropriate
hardware, including sensor with cleaning jets, a solenoid valve to switch either
pressurized air or cleaning solution (water for example) to the cleaning jets in the

flow cell.
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2.6 LCD Display (OPTIONAL) Contrast Adjust

This option is not applicable to the Messenger PC Transmitter.
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3 System and Troubleshooting

3.1 View Channel Output Display

¥IEW CHANNEL OUTPUT .

channel 1 T mv
channel 2 [RENI mv
Channel 3 [TECII mv
channel 4 [TEFII mv

Msgr Amb Temp 23l DegcC

Turn Lamp OFF

External Lamp OFF
Show Raw Data

The Messenger includes a feature that allows the user to display the primary
measurement values (in mV) of the system directly on the screen. The “View
Channel Output” option in the “Diagnostics menu” will display the Channels
signals i.e. the direct beam value, scatter beam or other signal connected. The
scatter beam and direct beam values are the amount of light being received by
each of the direct and scatter beam detectors respectively. Forward scatter
turbidity is defined as the ratio of the amount of light scattered at 12° to incident
divided by the amount of light making it directly across the optical gap. As more
suspended solids or oil droplets are present, more light is scattered and less is
transmitted, making the ratio of these two become larger. The ratio value is
determined by dividing the scattered beam by the direct beam. This is the same
value that is recorded in the Sampled column of the View/Edit calibration Data

screen.
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3.2 Factory Calibration

PROCESS CALIBRATION
Sensor 1

Build Calibration
¥iew/ Edit Calibration
Fit Data

Copy factory table

MAIN MENU
BACK

The user may elect to switch to factory calibration if his measurement data using
the process calibration are not correlating. The factory calibration data may be
copied into the “Process Calibration” menu by selecting “Copy factory table”. A
data fit, on this transferred factory data may now be performed by selecting “Fit
Data”, the unit will use the factory calibration data to report the cell sample
analysis. At the factory, Formazin standards were used to create the calibration
data table. The Sensor is calibrated with at least 3 data points: a nominal 0 FTU
standard, a full-scale standard and a mid point standard. This feature is included
to allow easier troubleshooting by referencing known and factory verified
calibration. Alternatively the Field process calibrations may be checked against

the Formazin or diatomaceous calibration data performed at the factory.
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3.3 Toggling Between Factory and User Calibration

Help
FIT SENSOR. 1

Using

LINEAR FIT FACTORY DATA

SETUP SENMSOR. EQUATION
BACK

The user can activate the field calibration or the factory calibration. Selecting “Fit
Data” menu allows the user to select which calibration the system uses to
Display results. This is intended to give the user the ability to switch between
Factory and Process Calibration as a method of checking the existing primary

calibration or performing a new primary calibration.
3.4 Default parameters:

Take extreme care when you are trying to DEFAULT all the parameters.

@ This Option will DEFAULT ALL Parameters.

Consult factory before proceeding with this menu, as the system will require you
to either re-enter manually all the parameters or load back the setup file to go
back on line. Make sure that you have saved the setup before proceeding

with “Default values” option.
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CLEAR / RESET MENU

5YSTEM RESET

Default ¥alues

Clear Process Calibration

Elear Fackory Calibr ation

Clear Results

Default ¥alues |

Reset Alarms

DIAG MENU
Are You Sure?

DO NOT PROCEED UNLESS YOU HAVE SAVED YOUR SETUP IN
FILE MENU.

3.5 Access Levels and Codes
The system has three Access levels:
Operator: Default Access code 123

Technician: Default Access code 1234

Factory: Reserved for Factory Access.
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3.6 Error and Warning Messages

Error/Warning Messages Description

Restart the program to change

language.

For New Language settings to take effect

Restart the Messenger Application

CAUTION! Download-Program
required. Messenger will be

stopped. Continue anyway?

"Flip" Program is required to load the
Firmware. Messenger Device should be

stopped to load the Firmware

Save these values?

Existing Parameters have changed. Do

you want to save the NEW Parameters

Normalize to 0

Normalize means to set in relation to a
selected channel. If this channel is "0", it

would result in a "Divide by Zero"!

Warning: All Data in the Messenger
will be defaulted to factory settings,

Are you sure?

ALL the existing PARAMETERS &
PREVIOUS DATA will be lost and
Messenger will be defaulted to factory

settings

Value out of range

Entered value exceeds the specified

range of the parameter

Invalid File Format

Selected file (*.pda) is corrupt

Saving these values will cause in

Loss of "Previous Data"

Changing the existing parameters will

clear "Previous Data"

Invalid File Extension

Selected file doesn't have .pda extension

No Data Available

Currently there is no "Previous Data"

stored

No More Data Points

There are no more data points in the

current DATA frame to Navigate

Are you sure you want to clear

stored Results

"PREVIOUS DATA" of Selected Result

will be cleared
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Are you sure you want to clear all
stored Results

"PREVIOUS DATA" of ALL Results will
be cleared

Port not available

The Selected Comport (RS-232 / RS-485)

is used by another Application

Overflow! Reduce gain?

If you try to auto-set the gain, the signal
has to be in range. If gain is already high,

it has to be reduced to fit signal to range.

Fill blank fields!

Entered data contain NULL values

Please go online

Connect to Messenger Device

Entered code is not correct.

Entered Access Code doesn't match

Unit ID must be an integer between
0 and 255.

Entered Unit ID value is out of range

Invalid Data

Entered Data is Not Valid Ex: - characters

entered instead of Numeric value

Are you sure you want to exit this

program?

Exits the Application

NO RESPONSE: Please check
device ID# or run the search

function

Currently no Device exists in the Network
with the specified ID. Navigate to Select
Messenger and Run the Search Function
which gives the List of Devices present in
the Network

Changing language requires
closing of the program. Are you

sure?

Switching to a different Language

requires restarting the Application.

All data in the Messenger will be
overwritten with data from this

device. Are you sure?

Loading the parameters from .pda file will
cause ALL the current parameters to be

Overwritten.

Access codes cannot be modified
in OFFLINE mode

To modify the Access codes switch to
ONLINE mode.
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You are OFFLINE. Please load file

first

To Edit the parameters in OFFLINE
mode you need to First load the .pda
File.

NO RESPONSE

Communication between GUI and
Messenger Device has failed. Verify

the connections.

Lower Limit cannot exceed upper

Limit

Entered parameter Lower Limit value

exceeds the upper limit value.

Optics Fault

Optical Fault has occurred

Lamps Fault

Lamp Fault has occurred

Fault: -- mA

Fault is registered at Analog output.

Where -- Represents the fault current.

List of Codes displayed in STATUS BAR of MEASURMENTS SCREEN

are shown below.

1 Alarm 1 Active

2 Alarm 2 Active

3 Alarm 3 Active

4 Alarm 4 Active

CccC1 Cleaning Event1 Active
CC2 Cleaning Event2 Active
For Example: -

Code in STATUS BAR “1,3,CC1” indicates that Alarm1, Alarm2 and Cleaning

Event1 are currently Active

List of Messages displayed on LCD Display.

OpticFIt

Optical Fault has occurred

LampsFIt

Lamp Fault has occurred

Data Transfer...

Data Transfer between Messenger and
GUI in Progress
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Appendix

RS485 Connection: Messenger Module to Touchscreen PC (GUI)

RS-485 Cable from Messenger module connections to DB9
connector plugged into COM-2 port of Touchscreen PC.

Messenger Touchscreen PC
Module COM-2 Port
13 |(+) RS 485 DB9 Connector
14 |(-) RS-485 DB9 Connector
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6.2 Sensor Connections

6.2.1 Moniturb F (MTF)Turbidity: Dual Sensors

MTF DUAL sensor wire connections

The table below shows forward scatter sensor 1 and 2 detector connections to

the Messenger.

MONITURB F Sensor 1 and 2 (Forward Scatter) Flow cell(s)

Terminal Wire Cable Signal
# Color ID
1 Brown FS (12°) sensor 1 (—) Direct beam
2 White FS (12°) sensor 1 (+) Direct Beam
3 Black FS (12°) sensor 1 Shield (ground)
4 Yellow FS (12°) sensor 1 (=) 12 Deg. Sensor
5 Green FS (12°) sensor 1 (+) 12 Deg. Sensor
6 - - -
7 Brown FS (12°) sensor 2 (—) Direct beam
8 White FS (12°) sensor 2 (+) Direct Beam
9 Black FS (12°) sensor 2 Shield (ground)
10 Yellow FS (12°) sensor 2 (=) 12 Deg. Sensor
11 Green FS (12°) sensor 2 (+) 12 Deg. Sensor

The Messenger PC uses an “EXTERNAL” or supplemental (Condor) power
supply to drive the lamps of both MoniTurb F sensors.

The following connections are made to the Power Supply Control Board (located

inside the Messenger PC enclosure on the lower right corner of the back panel).
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Dual Sensors: Lamp connections on the Lamp Supply Control Board (5 VDC)

Sensor 1
Terminal
3 Lamp (Blue and Red) (+)
4 Lamp (Grey and Pink) (-)
Sensor 2
Terminal
5 Lamp (Blue and Red) (+)
6 Lamp (Grey and Pink) (-)

Wiring connections from Condor supplemental power supply to the Lamp Supply

Control Board:

Lamp Control Cable with three conductors: Orange/Yellow/Black

Interface between Messenger Module and Lamp Control Board

To External Lamp From
Power Supply Wire color Messenger
Control Board Module

9 Orange 29
10 Yellow 30
11 Black 31
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6.2.2 MoniTurb F (MTF) Forward Scatter Turbidity Sensor
MTF Detector Wire Connections to Messenger PC

MoniTurb —F Flow cell.

Terminal

Wire

Cable

# Color ID Signal

1 Brown FS module () Direct beam

2 White FS module (+) Direct Beam

3 Black FS module Shield (ground)

4 Yellow FS module (=) 12 Deg. Sensor
5 Green FS module (+) 12 Deg. Sensor
6

7

8

9

Messenger Lamp supply connections (lamp connector located on the
Messenger Module (5 VDC)

Terminal

1

Lamp (Blue and Red) (-)

2

Lamp (Grey and Pink) (+)
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6.2.3 MoniTurb S (MTS) Side Scatter Turbidity Sensor
MTS Detector Wire Connections to Messenger PC

MoniTurb —S Flow cell.

Terminal Wire Cable Signal
# Color ID
1 Brown FS module (~)Direct beam
2 White FS module | (+) Direct Beam
3 Black FS module Shield (ground)
4 Yellow FS module (=) 90 Deg. Sensor
5 Green FS module (+) 90 Deg. Sensor
6
7
8
9

Messenger Lamp supply connections (lamp connector located on the
Messenger Module (5 VDC)

Terminal
1 Lamp (Blue and Red) (-)
2 Lamp (Grey and Pink) (+)
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6.2.4 MoniTurb Forward and Side Scatter (MTFS) Turbidity Sensor
MTFS Detector Wire connections

Terminal

Wire

” Color Cable ID Signal
1 Brown FS module () Direct beam

2 White FS module (+) Direct Beam

3 Black FS module Shield (ground)

4 Yellow FS module (=) 12 Deg. Sensor

5 Green FS module (+) 12 Deg. Sensor

6 - - -

7 Yellow SS module (=) 90 Deg. Sensor

8 Green SS module (+) 90 Deg. Sensor

9 Black SS module Shield (ground)

Messenger Lamp supply connections: located on the Messenger Module (5

VDC)
Terminal
1 Lamp (Blue and Red) (-)
2 Lamp (Grey and Pink) (+)
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6.2.5 Model 450 COLOR sensor connections

Te";“"a' C‘Q’) ilr:r Cable ID Signal
1 Brown MS-450 module (-) Reference Beam
2 White MS-450 module (+) Reference Beam
3 Black MS-450 module Shield (ground)

4 Yellow MS-450 module (=) Measure Beam
5 Green MS-450 module (+) Measure Beam
6 - - -
7 - - -
8 - - -
9 - - -
10 - - -
11 - - -
12 - - -

Lamp supply connections must be connected to the Lamp Supply Control Board

in the Messenger PC

The Model 450 sensor lamp should NOT be powered directly from the

Messenger module.

Connections are made to Pins 3 and 4 of the Lamp Supply Control Board.

Terminal
3 Lamp (Orange) (+)
4 Lamp (Green) (-)
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6.2.6 MoniSpec AD (MSAD) Color Sensor
MSAD detector wire connections to Messenger

Te";i"a' <‘:A<I>i|r:r Cable ID Signal
1 Brown MS-AD module (-) Reference Beam
2 White MS-AD module (+) Reference Beam
3 Black MS-AD module Shield (ground)
4 Yellow MS-AD module (=) Measure Beam
5 Green MS-AD module (+) Measure Beam
6 - - -
7
8
9

Messenger Lamp Supply Connection lamp supply connector located on the
Messenger Module (5 VDC)

Terminal
1 Lamp (Blue and Red) (-)
2 Lamp (Grey and Pink) (+)
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6.2.7 MoniSpec A (MSA) Color & Concentration Sensor
MSA detector wire connections to Messenger*

Terminal Wire Cable Signal
# Color ID
1 Brown MS-A module (=) Measure Beam
2 White MS-A module (+) Measure Beam
3 Black MS-A module Shield (ground)
4
5
6 - - -
7
8
9

* MSA uses only terminals 1, 2, and 3.

Messenger Lamp Supply Connection: located on the Messenger Module (5 VDC)

Terminal
1 Lamp (Blue and Red) (-)
2 Lamp (Grey and Pink) (+)
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6.2.8 Model FS4/FS5 Sensors

Probe Detector wire connections to Messenger.

Terr;inal (\:Nire Cable Signal
olor ID
1 Black Probe module (—) Sense Beam
2 Red Probe module (+) Sense Beam
3
4
5
6
7
8
9
10
11
12

Probe LIGHT source Connections on the Messenger Module.

Terminal

Wire

Cable

# Color ID Signal
1 Green Probe module (=) LED
2 White Probe module (+) LED
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6.2.9 Model 22 & 25 (CSK, CSS, CSH, CSG) Probes

Probe detector wire connections to Messenger

Terminal

Wire

Cable

# Color ID Signal
1 Black Probe module | (-) Sense Beam
2 Red Probe module | (+) Sense Beam
3 Green Probe Module | Shield (ground)
4

5

6

7

8

9

10

11

12

Probe LIGHT source Connections on the Messenger Module

Terminal Wire Cable Sianal
# Color ID 9
1 White Probe module (=) LED
2 Orange Probe module (+) LED
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6.2.10 Model 210 (TS2) Turbidity Sensor

TS2 Detector wire connections to Messenger

Terminal Wire Cable Signal
# Color ID
1 Black TS2 module (=) Direct Beam Detector
2 Red TS2 module (+) Direct BeamDetector
3 White TS2 module Shield (ground)
4 Green TS2 module (=) 12 Degree Detector
5 Yellow TS2 module (+) 12 Degree Detector
6 - - -
7
8
9

Lamp connections must be connected to the Lamp Supply Control Board in the
Messenger PC

Terminal
3 Lamp (Orange) (-)
4 Lamp (Green) (+)

The Model 210 lamp should not be powered directly from the Messenger module.
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6.3 Power supply Jumper configuration:

The power supply may be configured to power up either the standard sensors

with Flow cells or the FS4 & FS5 series cell density probes.

The settings are as follows:

1Amp

Flow Cell lamps (1Amp typical current at approximately 5V).
Includes the following sensor series: MoniTurb, MoniSpec,
Model 210 & 450.

OO0

300 mAmps

CSS, CSK probes and FS4 & FS5 BIO-PROBES
(position 3-4) as shown below (approximately 300mA
current).

O OO0
O OO0 QOO

These jumpers are set at the Factory.

@ DO NOT MODIFY
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6.4 OPTIONAL Lamp Supply Control Board

Using the OPTIONAL Lamp Supply Control Board the user may power multiple
sensors. The sensors may be Flow cells (MTF, MTS, MSA, MSAD, etc.) using
Lamps or Probes (CSK, CSS, FS4, etc.) using LED'’s.

The Messenger PC with Lamp Supply Control Board enables the customer to
connect the following sensors to one Messenger PC converter:
e 1 Model 210 (TS2) e 2 MoniTurb F e 2 MoniSpec AD
e 4 CSK probes e 2 MoniTurb S e 2 MoniSpec A
e 4 CSS probes

The Board has jumpers for selecting the type of sensor lamp to power. Jumpers
J4, J5 and J6 on the Lamp Supply Control Board are for selecting the source as

either a sensor with a Halogen Lamp or a Probe with an LED.

For sensors with Halogen lamps (MTF, MSA, MSAD, etc.) the Jumper(s) is/are
INSTALLED (1A current). For sensors with LED(s) (CSK, CSS, FS4, etc.) the
Jumper(s) is/are REMOVED:

Jumper Sensor For Sensor For Probes
# # with Halogen Lamps with LED
J4 1 Jumper Installed Jumper Removed
J5 2 Jumper Installed Jumper Removed
J6 3 Jumper Installed Jumper Removed

® CONNECTING A PROBE DEVICE TO A CHANNEL THAT IS
CONFIGURED FOR A LAMP DEVICE WILL DAMAGE THE PROBE.

NOTE: These jumper settings are configured at the factory and should not
be changed.
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EXTERNAL LAMP CONTROL CONNECTOR PIN OUT:

+5V at 4 A MAX (from Power supply)

GND (-) (from Power supply)

SENSOR (+) #1 (LAMP/PROBE) Ja

SENSOR (-) #1 (LAMP/PROBE)

J5

)
SENSOR (+) #2 (LAMP/PROBE)
SENSOR (-) #2 (LAMP/PROBE)

SENSOR(+) #3 (LAMP/PROBE) s

SENSOR (-) #3 (LAMP/PROBE)

LAMP ON/OFF (H/L) Control FROM Messenger Pin 29 (Orange wire)

LAMP FAULT (L) signal TO Messenger Pin 30 (Yellow wire)

= =2 ©| 0 N| O O] & W N| =

N )

GND (-) connects to Messenger Pin 31 (Black wire)

JUMPERS J1 thru J3 (ACTIVE)
These jumpers control activation of the fault detection for each of the connected

devices:

For example, if you have a sensor (with Halogen Lamp or LED) connected to
terminals 3 and 4 then you may enable fault detection for this sensor (lamp or

LED) by placing a jumper in position 1 (JP1) i.e.:

Connect Jumper #1 to enable Fault signal from | Sensor #1
Connect Jumper #2 to enable Fault signal from | Sensor #2
Connect Jumper #3 to enable Fault signal from | Sensor #3

Sensor Lamp (or LED) Fault is Signaled when Device is OPEN or when the
current to the Device drops below 200 mA (Fault Setup is done using “LAMP

CONTROL” menu using the graphical user interface software).

The Lamp Supply Control Board has the following LEDs:
RED LED s ON when Fault is detected

Green LED is ON when power is ON (Control from Messenger)
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6.5 Internationalization

Messenger Software Supports 4 Languages English, German, French and
Spanish.

I. Run the Messenger Application
Il. Choose > Select Language to switch to different language

Note: - Selected language should match with Regional settings of the computer

-54-



6.6 On-Line Help menus and related contents

This section describes the HELP menus and related contents.
Software HELP menus

6.6.1 Main Menu

This menu helps in navigating to various Messenger options.

Choose Main Menu
= Calibration Menu

=  Setup Results Menu
=  Setup Inputs/Outputs
= Diagnostic Menu

= Set Cleaning Event

= Set Access Code

= Set Access Level

= Measurements screen
6.6.2 Set Calibration Menu

This menu is used to correlate raw data collected from the sensors (photo detectors)
corresponding to a specific standard or sample concentration. Up to 8 different
calibration data points can be stored for each of the four sensors read by the

instrument. From this information the instrument can construct a lookup table.
Choose Main Menu > Calibration Menu

Select the Sensor, which needs to be calibrated.

You have two calibration tables, Factory calibration and Process calibration
tables. Choose the desired calibration table, which needs to be changed by
selecting the respective button

= Factory Calibration

= Process Calibration
Note: Factory calibration table can be altered / viewed using FACTORY level

Access permissions.
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6.6.2.1 Process Calibration

=  Build Calibration

=  View/Edit Calibration

=  Fit Data

= Copy Fact Table
Build Calibration

For each Sensor, up to 8 different samples can be used during the calibration

process.

Select the Sensor number by choosing the Sensor Toggle Button.

Select the Sample number by choosing the Sample Toggle Button.

Enter the User Value (Ex: - Known concentration value of a Standard) in the text
box provided. This value can also be changed using View/Edit Calibration

menu.

Choose Read New Data to capture the data.
Choose Store New Value to store the data.
Repeat steps 2 to 5 for each sample.

View/Edit Calibration

The selected Sensor number appears on the top. The data present in the
selected process calibration table can be viewed/edited using the following

option.

To edit user value or data, Tap/Click on the cell.
Choose Graph to view the curve fit based on the Fit Type selected.

Choose Edit Sensor Equations to alter the Sensor Equations.
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Fit Data
Choose the type of Curve Fit to be performed on the Calibration data. There are

4 options available.

» Linear Fit Process Data
= Curve Fit Process Data
» Linear Fit Factory Data
= Curve Fir Factory Data

Copy Factory Table
The selected sensor's factory calibration table is copied to process calibration
table.
6.6.2.2 Factory Calibration
= Build Calibration
= View/Edit Calibration
Build Calibration
For each Sensor, up to 8 different samples can be used during the calibration

process.

Select the Sensor number by choosing the Sensor Toggle Button.
Select the Sample number by choosing on the Sample Toggle Button.

Enter the User Value (Ex: - Known concentration value of a Standard) in the text
box provided. This value can also be changed using View/Edit Calibration

menu.

Choose Read New Data to capture the data.
Choose Store New Value to store the data.

Repeat steps 2 to 5 for each sample.
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View/Edit Calibration

The selected Sensor number appears on the top. The data present in the selected

factory calibration table can be viewed/edited using the following option.
To edit user value or data, Tap/Click on the block.

Choose Graph to view the curve fit based on the Fit Type selected.
Choose Edit Sensor Equations to alter the Sensor Equations.

6.6.3 Setup Results

The Setup Results are used for formatting the output that is to be displayed to
the user, which is captured from different sensors

Choose Main Menu > Setup Results Menu. You will see different Options to
format the output

= Setup Results Nametags
= Setup Results Equations
=  Setup Sensor Equations
=  Setup Numerical Results
= Setup Graphical Results
= Set Results Units

= Setup Data logging

= Bubble Reject Threshold
= Set Results Format

=  Set Results Offset

6.6.3.1 Setup Results Nametag

Choose the Result (1...4) Text box to specify the Nametags to be displayed for

results captured in the Measurements Screen.

For Example: - If the data captured in Result1 is Turbidity then the Nametag for
Result1 can be given as "Turbidity"
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6.6.3.2 Setup Results Equation
Choose the Result (1...4) text box to specify the Result Equations.
Rules for Result Equations:

1. An Equation can consist of 5 terms combined by operators.
2. Each term can be a sensor or logarithm of sensor and can have a
numerical factor.

3. The fifth term is +/- offset and can only be added.

For Example: -

The Equation is constructed by "term1 [op] term2 [op] term3 [op] term4 + offset”
where each term can be a sensor or the logarithm of sensor and has a numerical
factor (i.e. 3.67LogSEN4). The operators [op] can be +, -, *, /.

6.6.3.3 Setup Sensor Equation

Choose the Sensor (1...4) text box to specify the Sensor Equations.

Rules for Sensor Equations:

1. An Equation can consist of 5 terms combined by operators
2. Each term can be a channel or logarithm of channel and can have
a numerical factor

3. The fifth term is +/- offset and can only be added

For Example: -

The Equation is constructed by "term1 [op] term2 [op] term3 [op] term4 + offset”
where each term can be a channel or the logarithm of channel and has a
numerical factor (i.e. 3.67LogCH1). The operators [op] can be +, -, *, /.
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6.6.3.4 Setup Numerical Display

You can format the Numerical display. Check on relevant Show Result
checkboxes to select which results need to be displayed during the Numerical

display in Measurements screen.

Choose Font Size Toggle Button to specify the Font Size (Small / Medium/
Large) with which the results need to be displayed.

= When all results are selected for display Font size can be only small.
= When 3 results are selected for display Font size can be Small/Medium.
= When 2 or less results are selected for display Font size can be

Small/Medium/Large.

Choose Show All when all results need to be displayed.

6.6.3.5 Setup Graphical Display

You can format the Graphical display in Measurements screen. Check on Show
Result checkboxes to select which of the results need to be displayed during the
Graphical display.

ChooseRange of Values to specify the Lower & Upper Limits of the Graph.
Choose Time Step in Minutes to specify the time duration with which the X-Axis

Scale needs to be displayed.

Choose Show Color to select the color with which the result should be displayed
on the graph.

Note: Time Step in seconds can be specified by entering decimal values
Ex:-0.1,0.2.
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6.6.3.6 Set Results Units
Choose the Result (1...4) Text box to specify the units to be displayed for results

captured in the Measurements Screen.

For Example: - If the data captured in Result1 is Turbidity then the unit of Result1
can be given as "FTU".

6.6.3.7 Setup Data Logging

You can specify the Time Interval (Sec) with which the data needs to be stored in
buffer for each result.

Choose Store Result1 (1...4) text box to specify the time in seconds.

Choose Set Buffer Size to Specify the Buffer Size for each Result

In order to default the values Choose Set Default Values (i.e. 60 Seconds).
Note: Changing Data Logging rate clears the PREVIOUS DATA of the selected
Result.

6.6.3.8 Setup Buffer Size

Choose Result Storage Size (1.... 4); specify the storage size of each result.

If the data to be stored exceeds the Result storage size, Existing data is
overwritten.

Choose Default Values (i.e. 500)

Note: Total maximum stored results can’t exceed 8000.
Changing the Buffer Size clears PREVIOUS DATA of ALL Results.
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6.6.3.9 Bubble Reject Threshold

Bubble Reject Filter is used to smooth system response when bubbles are
passing and based on a data averaging and acts upon a threshold limit set by the

user in %change detection.
Choose Bubble Reject textboxes to specify the % Threshold.

Choose Filter Delay textboxes to specify the delay in sec.

6.6.3.10 Set Results Format
You can format the results displayed in Measurements screen.

Choose Number of Decimal Places for each Result to specify the precision with

which the result needs to be displayed in Measurements Screen.

Choose Allow Values for each Result to specify whether POS (Positive values)

or ALL (Positive and Negative values) to be displayed in Measurements Screen.

6.6.3.11 Set Results Offsets
Choose OFFSET TO RESULT (1...4) text box to specify the Offset.

The Offset Specified here will be a part of the Setup Results Equations.

6.6.4 Setup Inputs/Outputs Menu
You can configure the Inputs / Outputs of the Messenger Device.

Choose Main Menu > Setup Inputs / Outputs Menu. You will see the following
Options.

= Set LCD Display

= Set Analog Outputs

= Assign Digital Inputs

= Set Alarms

= Set Messenger Unit ID

= Set Relay Functions
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6.6.4.1 Set LCD Display

This option is not applicable to the Messenger PC.

6.6.4.2 Set Analog Outputs

The system has FOUR independent and assignable Analog 0/4 -20 mA loops,
which can be connected to External Devices. Each output will operate from a
user-defined RESULT equation. The sub-menus allow you to set all the
necessary parameter values for Low and High limits and the required mode for

the analog output.

Over range:

Analog Outputs can flag abnormal conditions or upset conditions that can be
caused by Malfunction of Optics or by some material coating over the windows.
We can assign a range of mV for normal operation. If the range exceeds, a fault
is registered and an appropriate error message (OPTICS FAULT) will be
displayed on the LCD and Measurements Screen.

How to configure Analog Outputs?

» To configure the Analog Output, Choose the ANALOG OUT (Out 1-4).

» Choose Output Toggle Button (Not Assigned / Result1 / Result2 / Result3
/ Result4) to specify the user defined RESULT equation needs to be
assigned to ANALOG OUTPUT.

» Choose Mode Toggle Button to Specify the Mode (0/4-20 mA) Loops.

» Choose Low, High text boxes to specify the Low and High mV.

» Choose Overrange toggle button to specify the channel (CH1...4) Assign
the range of mV for normal operation by choosing the Low mV and High
mV.

Note: In case any of the Analog Output is not used, make sure that OUTPUT,
OVERRANGE parameters are "NOT ASSIGNED".
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6.6.4.3 Assign Digital Inputs

e Choose Cleaning Event 1...2

e Set Cleaning Frequency in Hours = 0
e Specify the Cycle Duration, and Purge Time. Save the settings. Activate the

Relay through Assign Digital Inputs. The Cleaning Cycle gets activated ONLY
ONCE.

Note: Whenever you are trying to activate a Cleaning Event through Assign
Digital Inputs make sure that the Cleaning Frequency in Hours is 0.

Failing to do so may cause malfunctioning of the Cleaning Event.

6.6.4.4 Set Alarms

You can setup Alarm set conditions. Each Alarm can have a HYSTERESIS and a
TIME DELAY (the condition must be met for at least this time before the alarm is
reported). The alarm mode (LOW, HIGH, LOW LATCH, HIGH LATCH) can be

selected per individual Alarm.

Alarms can be assigned to the following signals

= Result1
= Result2
= Result3
= Result4

=  Ambient Temp
= General Alarm

The different Alarm Types are

= Low
= Low Latch
= High
= High Latch

Choose on the Alarm (1- 4).

Specify the signal to which the Alarm needs to be assigned by Choosing on the
Assigned Signal Toggle Button.
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Choose Type Toggle Button to specify the type of Alarm.

Choose Limit text box to specify the mV. Choose Delay on Make/Break Text box
to specify the delay in which the condition needs to be met at least before the
alarm is reported.

Choose on Hysteresis to Specify the Hysteresis value

The Hysteresis value will not have any affect for High and Low Latches.
In case any of the Alarms are not used, make sure that Type and Assigned
Signal are "NOT ASSIGNED".

6.6.4.5 Set Messenger Unit ID
The UNIT ID is necessary when multi-units are connected on the same bus.

Choose Unit ID to specify the ID of the Messenger. The Unit ID should lie
between 1...255.

Choose Messenger Tag to specify the extra information for easy identification

when multiple devices are connected in the network.

6.6.4.6 Set Relay Functions

This menu allows the user to assign the FUNCTION of the Relay.

Functions available are:
= NOT ASSIGNED
= Alarm 1
= Alarm 2
= Alarm 3
= Alarm 4
= General Fault
= Cleaning device 1
= Cleaning device 2

Relay functions in 2 states
= Active ON
= Active OFF Fail -Safe
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ACTIVE ON:
As long as assigned function is TRUE The Relay stays in activated state.
For Example:

The Alarm 1...4 are selected and thresholds are defined in the Set Alarm menu. If
we set an Alarm on Result 1 exceeding a threshold of 100 and we assign Relay
#1 as an indicator of such Alarm condition, the Relay#1 is activated when this
threshold is reached or exceeded based on the Alarm mode latching or NON-

latching. It would reset when the Result is back below the threshold defined.

ACTIVE OFF Fail Safe:
As long as the Assigned signal is FALSE the Relay stays in activated state
For Example:

The Alarm(s) 1...4 are selected and thresholds are defined in the Set Alarm
menu.

If we set an Alarm on Result 1 exceeding a threshold of 100 and we assign Relay
#1 as an indicator of such Alarm condition, the Relay#1 is NOT activate as long
as the Alarm condition is TRUE.

6.6.5 Diagnostic Menu
This menu is provided with diagnostic tools.

Choose Main menu > Diagnostic Menu, you will see a list of Diagnostic options.
* File menu
= View Channel Output
» Adjust Hardware settings
= Hardware Test
=  Software Revision

=  (Clear Reset Menu

-66-



6.6.5.1 File Menu

The parameters set by the user can be saved and these can be retrieved at a

later point of time.

Choose Save Parameters to File. You will see a dialog pop up Specify the
name of the file in which the parameters need to be saved. These files will be

stored with .pda extension and are referred as PDA Files.

Choose Load Parameters from File. You will see a dialog pop up. Select the file
in which the parameters have been stored earlier. During the process of reading
the data from the File and Transferring to Messenger Device, the percentage of

data that has been transferred will be displayed on the button.

Choose Load Firmware to prepare the Messenger Device ready for Installation

of Firmware.

6.6.5.2 View Channel Outputs

Here you can view the outputs from all the 4 channels and Messenger Ambient
Temp.

Raw Data:
Raw Data is channel mV displayed irrelevant of ZERO DARK CURRENT.

Channel Signal:
Channel signal is Channel mV displayed after we subtract the ZERO DARK
CURRENT.

Choose Show Raw Data / Show Channel Signal Toggle Button to switch

between the display of Raw data and Channel signal.
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6.6.5.3 Adjust Hardware Settings
Using this menu. You can adjust the hardware settings

= Zero Dark Current

=  Optimize Channel Auto

=  Optimize Channel Manual
= Set Dark Current Auto Zero
= Set Channel Reference

= Calibrate Analog Outputs

= Set ADC-GAIN Manual

Zero Dark Current
You can store the Zero Dark Current using this menu.
Choose "ZERO CHANNELS" to store the dark current. The lamps are turned

OFF and the system will take a reading for ALL the channels and stores it as

Dark current.

Choose "Restore Defaults Settings" to set the Zero Dark Current to 0.

Optimize Channel Signal Auto

The Messenger Device is provided with Multi Stage Amplification. The Primary
stage of Amplification is done with help of Front End Amplifiers and Secondary
stage of Amplification is done with the Analog to digital converter (ADC) that has

an internal amplifier.

The Front End Amplifiers setting can be done using Optimize Channel Auto.

%Range is related to the set point i.e. 100% which is 2000mv and 120% is 2500
mV which is the range of the ADC Converter.
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Raw mV displays the current channel mV

Choose Channel (CH1...4)

When a Channel is selected and the Optimize Gain key is entered, the
Messenger will try to set the Gain (Increase or decrease) to adjust the output
level of the amplifier to 2000 mV (with range set at 100%) or higher if the 100% is
higher, this relates to the A/D input of 2500 mV (80 to 120%).

Choose Restore Default Settings to restore the %Range to the default value i.e.
100.

The TRIMPOTS of the Front End Amplifier can be selected manually using
Optimize Channel Manual.

Optimize Channel Signal Manual

This shows the TRIMPOT settings on the front end Amplifier Range 0 to 100.
Choose Channel (1...4) and Tap/Click on "+" or "-" in order to increment or
decrement the TRIMPOT Settings.

Auto Zero Dark Current

Choose Auto Zero Frequency in Hours text box to specify the Time Interval
(Hours) at which the Dark current should be made zero.

Store Channel Reference

Using this option you can store a reading from a channel, which allows us to
store an initial reference reading for the channel.

For Example:

When doing a color measurement with a single channel (detector) the equation

for sensor may look like the following:

LOG REF CH1 - LOG CH1. Where LOG REF CH1 is a constant as it relates to
the initial energy level with clear water in the cell.
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Store Reference:

Choose CH (1...4).
When a channel is selected and STORE REFERNCE key is entered the current

reading of the channel will be stored as Reference

When a channel is selected and RESET REFERENCE key is entered the

Reference value will be defaulted to zero.

Normalization:

Choose CH (1...4).
Choose the channel (CH1 / CH2 / CH3 / CH4) with which the selected channel

needs to be normalized and Normalized Key is entered. The Channel gets
normalized.
Note:

Normalized Channel values are displayed in Green color.

Calibrate Analog Outputs

You can Calibrate Analog Outputs or adjust the 0/4- 20 mA loop, this is like a trim
pot adjustment.

For example, the 4 mA to 4.00 mA (Zero setting) and 20 mA to 20.00 (Factor
setting) as the technician sets these loops he can iterate between the zero and

factor to adjust the 4-20 mA exactly to the right levels.
Choose CH (1...4)
Choose Zero Setting and Tap/Click on "+" or "-" in order to increment or

decrement by 0.025.

Choose Factor Setting and Tap/Click on "+" or "-" In order to increment or
decrement by 0.0005 value.
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ADC-GAIN Manual

This is a secondary stage of Amplification setting on the ADC chip where we
have a FRONT end Amplification setting using the electronic trim pots which can

be adjusted using Optimize Channel Auto or Optimize Channel Manual.

ADC gain setting allows a second stage of amplification when we are looking at
very low signals and we need to amplify further beyond the front-end range

adjustment allowed.

This of course will cause a higher offset voltage and may reduce the range of the
detection because of this offset potential that is due to the multi-stage

amplification and the initial offset potential of the front-end op-amps.

The settings are defaulted to 1 but may be adjusted to 2,4,8,32,64,128
Choose Channel (1...4) and Tap/Click on the "+" or "-" in order to increment or

decrement the gain setting.

6.6.5.4 Hardware Test

This menu is used for testing of hardware
= Lamp Control
= Test Analog Outputs
= Test Relays

Lamp Control

You can view the current lamp's status and Lamp Intensity.
MAIN FAIL in Lamp Status indicates Lamp Failure.

Choose Display Fault Toggle (INT LAMP / EXT LAMP / BOTH LAMPS) button to

explicitly generate Faults.
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Choose Lamp Intensity text box to specify the percentage of Intensity of the
Internal lamp (only) terminal 1 & 2 on the Messenger module. This does not

work for the External lamp (Lamp Supply Control Board).

Choose Turn Lamp ON / Turn Lamp OFF Toggle Button to specify whether
Lamp needs to be Switched ON / OFF (Internal lamp ONLY). This is for the
Messenger’s setup for single sensors (only).

Choose External Lamp ON / External Lamp OFF Toggle button to specify
whether External Lamp needs to be ON/OFF (for supplemental Lamp Supply
Control Board ONLY). This is for the Messenger’s setup for multiple sensors

(lamps).

Test Analog Outputs

This Menu displays the mV of the FOUR Analog Outputs. A Fault in the Analog
Output is displayed as "FAULT: 2mA" where 2mA is the current assigned during
the fault condition. You can also test the Analog outputs using this option.

For Example: -

Set Analog Out1 to the following parameters
OUTPUT = Result1

Low = Omv, High = 100mv

Mode = 4-20mA

OVERRANGE = CH1

Low mV = 0, High mV = 150

Choose Analog OUT1

Enter the 50 Millivolts in the Analog Output text box and choose the "Update
Outputs™ key. The current observed at the Analog OUT1 should be 12mA.

Choose Restore Previous to restore the Analog Outputs to previous values
before the entry of 50 Millivolts.
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Test Relays

This Menu displays the current status of the FOUR Relays i.e. Signal to which
Relay has been assigned and whether it is switched ON / OFF.

Choose the ON / OFF Toggle button to Switch ON / OFF the Relay.

6.6.5.5 Clear/Reset Menu

= System Reset
=  Default Values
= (Clear Process Calibration
= Clear Factory Calibration
=  Clear Results
= Reset Alarms
Choose System Reset to reset the Hardware.
Choose Default Values to default the parameters of the Messenger.
On Selection of Default Values, Factory calibration table will not be defaulted.
Clear Process Calibration

Choose Sensor (1...4).

On Selection of Sensor, choose Copy From Factory Table key. Factory
calibration table contents of the Selected Sensor are copied to the Process
calibration table.

On Selection of Sensor, choose Clear Table key. Process calibration table
contents of Selected Sensor are defaulted to 0.
Clear Factory Calibration

Choose Sensor (1...4)
On Selection of Sensor when Clear Table key is entered. Factory calibration

table contents of selected sensor are defaulted to 0.
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Clear Results
Choose Clear Results (1-4) to clear the historic data stored in the buffer.
6.6.5.6 Reset Alarms

This menu displays the status of the 4 Alarms.

ACTIVE in the status block with RED background indicates Alarm is ON.
In order to clear the Alarm, choose the Alarm with ACTIVE in the Status block
and choose Clear ALARM key.

6.6.5.7 Software Revision

The Menu displays the current Version Number of GUI and Messenger.
The Messenger Version will be displayed only when GUI is connected Online.

6.6.6 Set Cleaning Event

You can program up to TWO cleaning events.

A cleaning event is an automatic cycle that allows the optics to be CLEANED by

the introduction of a cleaning solution to flow through the cell.

For each Cleaning Event, you can specify the Cleaning Frequency, Cycle
Duration and Purge Time (Time to allow the Sample to flow and purge out the
cleaning solution). A Relay can be assigned to a Cleaning Event, which will be

active only during the Cycle Duration.

Cleaning Events can be activated in 2 ways, automatically or through Assigned

Digital Inputs.
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Automatic Mode:

Choose Cleaning Event 1...2
Specify the Cleaning Frequency, Cycle Duration, and Purge Time.

The Cleaning Event gets activated once you save the settings.

Assign Digital Inputs:

Choose Cleaning Event 1...2

Set Cleaning Frequency in Hours = 0

Specify the Cycle Duration, and Purge Time. Save the settings. Activate the Relay
through Assign Digital Inputs. The Cleaning Cycle gets activated ONLY ONCE.

When you are trying to activate a Cleaning Event through Assign Digital inputs
make sure that the Cleaning Frequency in Hours is 0. Failing to do so may cause
malfunctioning of the Cleaning Event.

6.6.7 Set Access Code

You can set Personal Access code for Operator, Technician and Factory Levels
preventing unauthorized personnel from altering key parameters that affect the

operation of the unit.
Choose Operator text box. An Interface pops up Specify the Operator Password.

Choose Technician text box. An Interface pops up Specify the Technician
Password.

Choose Factory text box. An Interface pops up Specify the Factory Password.

6.6.8 Set Access Level

You can enter the Access code based on the access code entered access level
changes.

Choose New Access Code text box. An Interface pops up Specify the new

Access code.

Note: On entering incorrect access code the Access Level will be defaulted to
Operator.
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6.6.9 Measurements Screen
= Previous Data
= Online Analysis
=  Alarm Status

6.6.9.1 Previous Data

Choose OPTIONS button =l on the top right corner of the measurements screen,

a popup menu appears.
Choose Previous Data.

Entire Previous Data is retrieved. Most recently logged data is displayed as first

frame of graph.

Choose Previous "<" and Forward " >" buttons on the bottom of the graph to

scroll through the Previous Data.

Note: This operation may take some time to read the data from device and

process the data.

Choose Numerical / Graph / Bar Toggle button to switch between display

formats.

How can you view value of data point on a graph area?

Tap on the data point you want to view on the graph area, Crosshair appears

displaying the X-axis and Y-axis data.

Choose Previous "<" and Forward ">" buttons to scroll through the data in the

currently displayed frame.

Tap outside the graph area to remove the crosshair.

How can you customize the Numerical and Graphical display?

Graph settings can be configured using the following screen
e Setup Numerical Display
e Setup Graphical Display
e Graph Settings
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6.6.9.2 Online Analysis
You can view data being captured by Messenger Device ONLINE.

The data captured from the Messenger Device can be viewed in 3 different
formats.

= Numerical Display

= Graphical Display

= Bar Chart Display
Numerical Display and Graphical Display can be customized using the Setup
Graphical Display, Setup Numerical display Menus.

Choose Numerical / Graph / Bar Toggle button to switch between the displays.

6.6.9.3 Alarm status
Status of Alarms is represented on the bottom of the Measurements screen.
Codes displayed in Alarm Status are shown below.

1 - Alarm 1 Active

2 - Alarm 2 Active

3 - Alarm 3 Active

4 - Alarm 4 Active

CC1 - Cleaning Event1 Active

CC2 - Cleaning Event2 Active
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6.7 Graph/Chart Recorder

1. Run the Messenger Application.
2. Navigate to Main Menu >Measurements Screen and Choose GRAPH
view.

Help
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3. Choose the Button on TOP Right corner of Graph, which displays a Popup

Menu with a list of options.
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View Previous Data

On Selection of Previous Data Menu. Results Selected in SETUP GRAPH
DISPLAY will be pulled from the Messenger and Displayed.

Once the data is retrieved from the Messenger, the data is plotted on the Graph.
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Choose the FORWARD and BACK buttons to navigate through the DATA SETS.
Each data set displayed contains 100 points or as many available in that group.
Data Sets are grouped based on DATE.

POINT UNDER CURSOR

Choose the point you want to view by Tap/Click on the graph area. A Cross Wire

with corresponding x, y values is displayed as shown below.
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Choose the FORWARD and BACK buttons to navigate through the Points
displayed on the Graph.

Note: To remove the Crosswire Tap/Click outside the Graph Plotting area
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When Cross wire is present the BACK and FORWARD buttons move the cross
wire through DATA POINTS in the absence of cross wire the BACK and
FORWARD buttons help in moving through the DATA SETS

View ONLINE DATA

Choose this option to get Online Data from Messenger.

Setup Graph Display

Choose Setup Graph Display a Dialog appears as shown below.

SETUP GRAPHICAL DISPLAY OF
RESULTS

Range of ¥alues

Time steps in Minutes

Show Result:

Select Color :

Show ALL

Range Of Values
Specify the Lower Limit & Upper Limit of the Graph.

Select Color
Click on Select Color of Result (1,2,3,4). A dialog pops up displaying the
list of colors. Select the color.

Show Result
Check the results that should be displayed on Graph.

After changing the above options Press on the BACK button the graph is
displayed with new selections taking into affect.
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Graph Settings

Choose Graph Settings a Dialog appears as shown below.

GRAPH SETTINGS .

Background Color:
Horizontal Tic Lines:
¥ertical Tic Lines:
Line Thickness:

¥ -Axis Precision:

[ Line Style Solid
[ show Grid Lines

BACK

Background Color
Click on the background color. A dialog pops up displaying the List of

colors. Choose the Color.

Horizontal Tic Lines
Specify the number of Horizontal tics to be displayed on the Graph.

Note: For tics greater than 10 the labels may overlap

Vertical Tic Lines
Specify the number of Vertical tics to be displayed on the Graph

If tic lines is <=2 the display is HH:MM:SS

If tic lines is >2 and < 6 the display is MM:SS

If tic lines is >6 the display is SS

Where HH Represent Hours, MM represent Minutes, SS Represent
Seconds.

Note: for tics greater than 9 the labels may overlap

Line Thickness
Specify the Line thickness.

Note: Display may not be proper if line thickness is greater than 3
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Y-axis Precision
Specify the precision with which the y-axis data needs to be displayed.

Line Style Solid
Select this option if line style needs to be solid. If it is not selected, the

line style will be dashed.

Show Gridlines
Select this option to Show/Hide Gridlines.

Copy Image
This feature is used to capture the graph as Image and transfer it to the

Clipboard.

The transferred Clipboard Image can be pasted in Word Document or in
any other applications that support Image clipboard.
To use this Choose Copy Image
Copy Data
This feature is used to capture the data present in the Graph and transfer

it to the clipboard.

The Transferred clipboard data can be pasted in Word / Excel or any other
applications that support clipboard.
To use this feature Choose Copy Data.
SaveAs Bitmap
This feature is used to capture the Graph Image and save as a Device

Independent Bitmap.

To use this feature Choose SaveAs Bitmap. Specify the Name of the File

and Location.
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6.8 Manufacturer’s Warranty Statement

Galvanic Applied Sciences Inc. (“Seller”) warrants that its products will be free
from defects in materials and workmanship under normal use and service in
general process conditions for 12 months from the date of Product start-up or 18
months from the date of shipping from Seller’s production facility, whichever
comes first (the “Warranty Period”). Products purchased by Seller from a third
party for resale to Buyer ("Resale Products") shall carry only the warranty
extended by the original manufacturer. Buyer agrees that Seller has no liability
for Resale Products beyond making a reasonable commercial effort to arrange
for procurement and shipping of the Resale Products. Buyer must give Seller
notice of any warranty claim prior to the end of the Warranty Period. Seller shall
not be responsible for any defects (including latent defects) which are reported to
Seller after the end of the Warranty Period.

THIS WARRANTY AND ITS REMEDIES ARE IN LIEU OF ALL OTHER
WARRANTIES OR CONDITIONS EXPRESSED OR IMPLIED, ORAL OR
WRITTEN, EITHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR
OTHERWISE, INCLUDING BUT NOT LIMITED TO, WARRANTIES OR
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, WHICH SELLER SPECIFICALLY DISCLAIMS.

Seller’s obligation under this warranty shall not arise until Buyer notifies Seller of
the defect. Seller's sole responsibility and Buyer’'s sole and exclusive remedy
under this warranty is, at Seller's option, to replace or repair any defective
component part of the product upon receipt of the Product at Seller’'s production
facility, transportation charges prepaid or accept the return of the defective
Product and refund the purchase price paid by Buyer for that Product. If
requested by Buyer, Seller will use its best efforts to perform warranty services at
Buyer’s facility, as soon as reasonably practicable after notification by the Buyer
of a possible defect provided that Buyer agrees to pay for travel time, mileage
from the Seller’'s facility or travel costs to the airport / train station closest to
Buyer’s facility plus all other travel fees, hotel expenses and subsistence.

Except in the case of an authorized distributor or seller, authorized in writing by
Seller to extend this warranty to the distributor’'s customers, the warranty herein
applies only to the original purchaser from Seller (“Buyer”) and may not be
assigned, sold, or otherwise transferred to a third party. No warranty is made
with respect to used, reconstructed, refurbished, or previously owned Products,
which will be so marked on the sales order and will be sold “As Is”.

Limitations
These warranties do not cover:
+ Consumable items such as lamps.

* Analyzer components which may be damaged by exposure to
contamination or fouling from the process fluid due to a process upset,
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improper sample extraction techniques or improper sample preparation,
fluid pressures in excess of the analyzer's maximum rated pressure or
fluid temperatures in excess of the analyzer's maximum rated
temperature. These include but are not limited to sample filters, pressure
regulators, transfer tubing, sample cells, optical components, pumps,
measuring electrodes, switching solenoids, pressure sensors or any other
sample wetted components.

+ Loss, damage, or defects resulting from transportation to Buyer’s facility,
improper or inadequate maintenance by Buyer, software or interfaces
supplied by Buyer, operation outside the environmental specifications for
the instrument, use by unauthorized or untrained personnel or improper
site maintenance or preparation.

* Products that have been altered or repaired by individuals other than
Seller personnel or its duly authorized representatives, unless the
alteration or repair has been performed by an authorized factory trained
service technician in accordance with written procedures supplied by
Seller.

* Products that have been subject to misuse, neglect, accident, or improper
installation.

« The sole and exclusive warranty applicable to software and firmware
products provided by Seller for use with a processor internal or external to
the Product will be as follows: Seller warrants that such software and
firmware will conform to Seller's program manuals or other publicly
available documentation made available by Seller current at the time of
shipment to Buyer when properly installed on that processor, provided
however that Seller does not warrant the operation of the processor or
software or firmware will be uninterrupted or error-free.

The warranty herein applies only to Products within the agreed country of original
end destination. Products transferred outside the country of original end
destination, either by the Seller at the direction of the Buyer or by Buyer’s actions
subsequent to delivery, may be subject to additional charges prior to warranty
repair or replacement of such Products based on the actual location of such
Products and Seller’s warranty and/or service surcharges for such location(s).

Repaired Products
Repaired products are warranted for 90 days with the above exceptions.

Limitation of Remedy and Liability

IN NO EVENT SHALL SELLER BE LIABLE TO BUYER FOR ANY INDIRECT,
CONSEQUENTIAL, INCIDENTAL, SPECIAL OR PUNITIVE DAMAGES, OR
FOR ANY LOSS OF USE OR PRODUCTION, OR ANY LOSS OF DATA,
PROFITS OR REVENUES, OR ANY CLAIMS RAISED BY CUSTOMERS OF
BUYER OR ANY ENVIRONMENTAL DAMAGE OR ANY FINES IMPOSED ON
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BUYER BY ANY GOVERNMENTAL OR REGULATORY AUTHORITIES,
WHETHER SUCH DAMAGES ARE DIRECT OR INDIRECT, AND
REGARDLESS OF THE FORM OF ACTION (WHETHER FOR BREACH OF
CONTRACT OR WARRANTY OR IN TORT OR STRICT LIABILITY) AND
WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR NOT.
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